How to Import Timesheet Data into Payroll Mate
Using T-Sheets

Note: In order to use this feature you must purchase and enable Payroll Mate Option #3
(Additional Companies & Employees + Timesheet Import)

To Export your data from T-Sheets:

Be sure the CSV file includes the following data: First Name, Last Name and Per Hour Income
Categories. Custom income categories will need a column created for each income category
used for payroll processing. Any employee imported from the CSV file will be included in the
paycheck processing (including non-hourly).

1. Click More from menu
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2. Select Payroll

3. Select Payroll Hrs Summary by Employee

° TRACK

My Time Card

Time Entries

Paid Time Off (PTO)

E REPORT

Approvals Report Select Payroll | 2

Payroll Report

Project Report

Schedule Reports »

More > PAYROLL ~

| Payroll Hrs Summary by Employee

# MANAGE
Employees ool
Jobs LOGGING AND AUDITI ~
Schedule EXPORTS -~
Who's Working TRACKING ~
£t seTup ~  EXCEPTIONS -
Company Settings
Add-ons Select Payroll Hrs 3
S Summary by Employee
PTO Codes
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4. Select Report Dates

5. Click Download CSV

"12:47 os

‘We've simplified our menu. EXPLORE A PREVIEW

g TRACK

My Time Card
Time Entries

Paid Time Off (PTO)

[ rerorT
Approvals Report Payroll Hrs Summary By Employee b4
Payroll Report
N Pa ol lire U e L Emrle Select Report Dates | 4

Schedule Reports  »

EEPORT DATES

More »
By pay-penod - 06/17 - 06/23, 2018 ¥
& MANAGE
Employees FILTER BY GROUPS / EMPLOYEES
All employees
Jobs
Schedule

. P Click Download CSV | 5

L3 seTup -~
Company Settings
Add-ons
Breaks

PTO Codes

6. Click Open

Click Open | 6

Doy weant 1o open of save payroll_hes_summary_2008-06-17_thna_2018-06-2 Losw from realbusin lutions. tiheetls oo

Seve T Cancel
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7. Review Employees to import

Note: The name needs to be separated into 2 columns (Last Name & First Name)
You can separate the names into 2 columns manually or follow steps 8-18 to have Excel
separate them.

If you do not want to split the name each time you do the export from T-sheets you can add the
employee SSN as the Payroll ID and map the SSN column inside Payroll Mate when you import
(instead of mapping the first name/last name-leave columns as Unused during mapping).

payroll_hrs_summary_2018-06-17_thru_2018-06-23 .csv - Excel O X
Formulas Data Review View Help QuickBooks P Tell me what you want to do ‘,!:_"_ Share
LS . = Eelnset - 2 - A
1 Calibri Sl - A A T== @ 2 Generl = ': 4 ¢ | = A p
P sltj ®- By 00 | C d't'zl I F ‘r. fﬁl £ Delcte = '-lv Szrt& Find &
aste i B I U- _ = My - === (-__E E = -9 t.-ﬂ onditional Format as &l — 0 n
.o A $ “ % Formatting~ Tabler Stylesw = Formats & - Firers Select+
Clipboard = Font [ Alignment & Number r. Styles Cells Editing ~
A fe P | A &
AL B PayrolllD Raview Employees
A B c g/lr G | H I 1|k L M | N 0 [4]
1 |PayrollID lEmpIdee Name Group  Salaried Exempt RegHours O/T Hours D/T Hours Holiday Hi Sick Hours Vacation F Approval State
2 |888-55-2222 0|Deaux, Fred 0 0 40 2 1] 0 0 0 approved
3 |111-22-3333 0|Sample, Samuel |- 0 0 32 0 1] 0 0 0 approved
4 |123-22-3333 0|Sample, Stuart |- 0 0 40 0 0 0 0 0 approved
5 |123-12-3123 0[Smile, Stacy 0 0 37 ] 0 0 0 0 approved
6§ 999-99-9395 0|Tester, Sally 0 0 40 1 0 0 0 0 approved
7 |998-99-9399 0[Tester, Tommy |- 0 0 32 0 o 0 0 0 approved
8 SUBTOTAL 221 3 0 0 0 0
9 -
10
11 GRAND TOTAL 221 3 0 0 0 0
12
13
14
15|
16
17 -
payroll_hrs_summary_2018-0 | ® :[a [
Ready =] |- [ ] + 100%
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8. Right-click on the Column after Employee Name

9. Click Insert to insert a blank column

N = = payroll_hrs_summary_2018-06-17_thru_2018-06-23 .csv - Excel
Insert  Pagelayout Formulas  Data  Review  View  Help  QuickBooks O Tell mewhat yo
s - - = - -
D * Calibri s <A A == @ ®© General [le 7 .} %ﬂhsm = é? p

Past: a- y o0 Conditional Format Cell & Delete - ,-]' Sort & Find &

B E B I v | . - -l=E== - $ -0 s %8 onditional Formatas Cel — in

- . & o Formatting~ Table~ Styles~ =l Format~ &~ Fjjter - Select -

Clipboard & Font ] Alignment ) Number ] Styles Cells Editing ~
DL - f || Group Right Click on Column -

After Employee Name
A B | c D I b K L M | N o [4]

1 [PayrolliID  Employee Name Group % Cut Reg Hours O/T Hours D/T Hours Holiday Hi Sick Hours Vacation F Approval State

2 |883-55-2222 0 Deaux, Fred - | Em Copy 40 2 0 0 0 0 approved

3 |111-22-3333 0 Sample, Samuel |- "'D Paste Options: 32 W] 0 0 0 0 approved
4 |123-22-3333 0 Sample, Stuart |- o o o 40 0 0 0 0 0 approved

5 (123-12-3123 0 Smile, Stacy - = 37 0 0 0 0 0 approved
6 [999-99-9999 0 Tester, Sally |- Paste 3pecial... 40 1 0 0 0 0 approved
7 |998-93-9999 0 Tester, Tommy |- 32 0 o o 0 0 approved
8 SUBTOTAL | Delete 221 3 0 0 0 0
9 — Clear Contents
10
11 GRAND TOTAL Format Cells... 71 2 0 0 0
12 Column With.. Click Insert E
13 Hide
L — Unhide
15
16
17 -

payroll_hrs_summary_2018-0 ‘ @ [4] >

Ready Count: 7 B o= 1 + 100%
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10. Click the Data Tab

11. Select the column with the full name

12. Click Text to Columns

E - C|le Data Tab payroll_hrs_summary _2018-06-17_thru_2018-06-23 .csv - Excel

File Home  Insert  Pagelayout  Formulas Review  View  Help QuickBooks 2 Tell me what yo £ Share
B E [ Show Queries E L.T-l Connections 8] Y E’E B E-‘n E\') @ ElEE Group ~
E From Table § Ex:) o “ 8 Ungroup ~
Get External  New Refresh z| Sort Filter Text to What-Jf Forecast
Data~  Query~ L Recent Sources 1 £ “ Vo Advanced | Columns| T Analysis*  Sheet £E]subtotal
Get & Transform Connections Sort & Filter Data Tools Forecast Outline 5 ~
= i L Click Text to Columns
Select Name Column .
A B o | E | F G | H | 1 )| K L M | N o [4]
1 |PayrollID  EmployegName Group  Salaried Exempt RegHours O/T Hours D/T Hours Holiday Hi Sick Hours Vacation F Approval State
2 |888-55-2222 0|Deaux, Fred - 0 0 40 2 o 0 0 0 approved
3 |111-22-3333 0|Sample, Samuel |- o 0 32 1] 0 0 0 0 approved
4 1123-22-3333 0| ple, Stuart |- ] 0 40 0 0 0 0 0 approved
5 [123-12-3123 0|smile, Stacy - 1] 0 37 0 ] 1] 0 0 approved
6 |999-99-9999 O|Tester, Sally |- 0 0 40 1 ] ] 0 0 approved
7 |998-99-9999 0|Tester, Tommy |- o 0 32 0 o 1] 0 0 approved
8 SUBTOTAL 221 3 0 0 0 1]
9
10
11 GRAND TOTAL 221 3 0 0 0 0
12
13
14
15
16
17 d| -
payroll_hrs_summary_2018-0 ‘ (O] s 4] 3
Ready Count: 9 B o - [ ] + 100%
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13. Select Delimited

14. Click Next

H ©- [ — A payroll_hrs_summary_2018-06-17_thru_2018-06-23 .csv - Exce

File Home Inset  Pagelayout  Formulas Help  QuickBooks & Tell me what you want to do
B = [T]Show Queries [2] Connections B e @ & Group ~
- z B B G,
[ From Table r b BB a ‘ & Ungroup ~
Get External  New Z| Sort  Filter Text 7 What-If Forecast
Data~  Query~ [ Recent Sources | Vo Advanced  Columns 55 7 Analysis = Sheet £ subtotal
Get & Transform Connections Sort & Filter Nata Taals 2 Outline ) »
= . & Tinara Select Delimited | 13
Convert Text to Columns Wizard - Step 1 of 3
The Text Wizard has determined that your data is p
i B c If this is correct, choose Next, or choose tpe®ata type that best describes your data. L | M | N B|
1 |Payroll ID  EmployedName Oliginatdataine By HiSick Hours Vacation t Approval Sta
2 |888-55-2222 Fred Choo ype ti > ’ s‘:descn:‘es your data: - . _— 0 0 0 approved
:aracters such as commas or tabs separate each field.
3 |111-22-3333 0|Sample, Samuel 0 0 0 approved
Sample,Samueh _) Fixed width - Fields are aligned in columns with spaces between each field. PP!

4 [123-22-3333 o|sample, Stuart 0 [} 0 approved

5 |123-12-3123 0|Smile, Stacy 0 0 0 approved

6 |999-99-9993 0|Tester, Sally [} 0 0 approved

7 |998-99-9999 0|Tester, Tommy g 0 0 0 approved

8 SUBTOTAL Click Next 0 0 0

9 Preview of selected data: \
i ame -
11 GRAND TOTAL aux, Fred 3 0 0 0

12 ample, Samuel

ample, Stuart

13 ile, Stacy 22

14 « » i
15
16 Cancel ] [ < Back ] |[ Next > ]| [ FEinish ]

17 -

payroll_hrs_summary 2018-0 | @ a0 5

Ready Count:9 B [~ [} + 100%

15. Select Comma

16. Click Next

H - 0O = = oll_hrs_summary_2018-
File Home Insert Page Layout Formulas LEE View Help QuickBooks /’: Tell me what you want to do
- i = : N [F Bo I:‘I E H
B r = Show Queries E Connections 8] Y En E & : g ) @ E Group
= From Table : 5 F BB =f - 28 Ungroup ~ ~
Get Bdernal  New F § 7| Set  Filter Tetto What If Forecast _
Data~  Query~ [ Recent Sources ? Vo Advanced  columns 56 T Analysis = Sheet £ subtotal
Get & Transform Connections Sort & Filter Data Tools Forecast Qutline £} ~
ci < £ || Nampa
Convert Text to Columns Wizard - Step 2 of 3 =]
This screen lets you set the delimiters your data contains. You can see how your text is affected
in the preview below,
A B c Dt L | M N [«]
elimiters
1 |PayrollID EmployeqName Pt Select Comma By Hi Sick Hours Vacation t Approval Sta
al
2 |888-55-2222 0|Deaux,Fred e S T e 0 0 0 approved
3 |111-22-3333 0 ple,Samuel 0 0 0 approved
4 [123-22-3333 0|Sample,Stuart B ;p!:e Text gualifier. |~ B 0 0 0 approved
5 [123-12-3123 0[Smile,Stacy [ Other: ] 1] 0 approved
6 |999-99-9999 0fTester,Sally 0 0 0 approved
7 [998-99-9999 o[Tester, Tommy 0 0 0 approved
8 SUBTOTAL Data preview . 0 0 1]
& Click Next
10 \
ame -
1 GRAND TOTAL caux [rrea @ § 0 0
12 ample [Samuel
ample [Stuart
13 mile [Stacy -
14 < v L]
15
16 cancel | [ <gack ]| o> | [ gnisn |
17 -
| payroll_hrs_summary_2018-0 | @ [«] I
Ready Count:9 B m - [ ] + 100%
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17. Review Data (remove any spaces in name)

18. Click Finish

H - 0 = - bayroll_hrs a1y, 2018-06-17_thru_2018-06-23 .csv - Exce

File Home Inset  Pagelayout  Formulas Review  View  Help  QuickBooks O Tell me what you want to do

7 [TIShow Queries Connections 4| [ZTA %. B B &8 Group ~
I d : | B B
[ From Table / BB =f o &8 Ungroup ~
Get External  New z| Sott Fitter Tetto What-If Forecast _
Data~ | Query~ L Recent Sources Vo Advanced | Columns 56 ~ Analysis~ Sheet | EEj Subtotal
Get & Transform Connections Sort & Filter Data Tools Forecast Outline = ~
c1 > = Narpa
Convert Text to Columns Wizard - Step 3 of 3
This screen lets you select each column and set the Data Format.
A 8 c Column data format L M N .
1 {payrollID _EmployegName = £ Goced ‘General’ converts numeric values to numbers, date values ~ PY H! Sick Hours Vacation t Approval Sta
2 |888-55-2222 0|Deaux,Fred D Text to dates, and all remaining values to text. 0 0 0 approved
3 [111-22-3333 o|sample,Samuel (| © Date: |MOY E| 0 0 0 approved
4 |123-22-3333 0|Sample,Stuart | () Do not jmport column (skip) 0 0 0 approved
5 |123-12-3123 0|Smile,Stacy q 0 0 0 approved
B Destination:
6 [999-99-9999 o|Tester,sally S SCiL Review Data (E3)) 0 0 approved
7 [998-99-9999 o|Tester, Tommy (no spaces) 0 0 0 approved
8 SUBTOTAL Data preview 0 0 [
9 ~
10 | |
11 GRAND TOTAL B .. 0 0 0
= R Click Finish ‘
13 I
14 »
15
16
17 <
payroll_hrs_summary_2018-0 ‘ ® < »
Ready Count9 [ m - 1 + 100%

19. Other than the top Header row, delete any rows that do not include employee information

20. Save the CSV file (File>Save As> use the CSV (Comma Delimited) file type

H ©- 0D & - payroll_hrs_summary_2018-06-17_thru_2018-06-23 .csv - Excel m] X

File Home Insert  Pagelayout  Formulas Review  View Help  QuickBooks  Tell mewhat youwant to do 2 Share

B Fl.j [ Show Queries Fg [2] Connections 8l Y E-.n E‘? @ EQ Group ~
Ej From Table N N a J &8 Ungroup ~
Get External  New Refresh z| Sort  Filter Tetto What-If Forecast _
Data~  Query~ [ Recent Sources  pjj~ Vo Advanced  columns o T Analysis = Sheet £ Subtotal
Get & Transform Connections Sort & Filter Data Tools Forecast Outline ] ~
A8 = Fe ~
A B © D E F G H 1 J K L M N [«
1 |Payroll ID  Employee Name Group Salaried Exempt Reg Hours O/T Hours D/T Hours Holiday HiSick Hours Vacation F Approval Sta
2 |888-55-2222 0 Deaux Fred - 0 0 40 2 0 0 0 0 approved
3 |111-22-3333 0 Sample Samuel 0 ] 32 0 0 0 0 0 approved
4 (123-22-3333 0 Sample Stuart - [} 0 a0 [} 0 0 0 0 approved
5 [123-12-3123 0 Smile Stacy - [} 0 37 [} 0 0 0 0 approved
6 [999-99-9999 0 Tester Sally - 0 0 a0 1 0 1) o 0 approved
| 7 |998-99-9399 0 Tester Tommy - 0 0 32 0 0 0 0 0 approved |
8 SUBTOTAL 221 3 0 0 0 0
9
10 | ] | | |
11 GRAND TOTAL ‘\ 221 3 o ] a o
h.
= N\
13 . r 2
o Delete data rows without Employee information
15|
16
7 File>Save As>CSV (Comma Delimited) type file . .
payroll_hrs_summary_2018-0 4] v
Ready Average: 3733333333 Count:14 Sumi443 | fH g - 1 + 100%
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Make sure you have the correct Company open inside Payroll Mate

21. Click Employees from Shortcuts

22. Click Import Timesheet Data

Click Import Timesheet Data | 22

Click Employees | 21
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23. Click Step (1) Click here to Load the Timesheet CSV file

(1) The input file is expected to be in the CSV (Comma Separated) format.
(2) The first row in the file is expected to iInclude header information and NOT data.

(3) The input file should not Include more than one row per employee.

(4) Any row that doesnt match an existing “Active™ empioyee (in the
currently open company) will NOT import.

(5) Row Matching is done based on the

of the Employee’s (First Name and Last Name).

s SSN OR the

{6) You cant have multiple employees with the exact same name (first name

and last name).

Step (1) Chick here o Load the Timesheet CSV file

||

(7) The number of hours should be in Decimal format. For example: enter 7.25
for 7 hours and 15 minutes.

Click Step (1) Click here to
Load the Timesheet CSV File

23

I Step (2) Click here to Import the Timesheet Entries into Payroll Mate l

( Close

]

24. Double-click to Select the Timesheet CSV file

Organuze v

W Favontes
B Oesitep
& Downloads
L. Recent Places
G OneDrve

i Uibraries
+ Documents
&' Music
e Pictures
B Videos

™ Computer
& Windows (C)

-~

‘[-Dumo »

New folder

= K

)

> l e 4 ‘I Search Desitop

=

0 e

Select CSV created
from T-sheets

24

u hu_2018-06-23.csv
<l Microsot Excel Comma Sepacate...

¥ data (\\rbsserver,

3

File name:  payroll_hrs_summary_2018-06-17_thry_2018-06-23.csv

+ | csv (Comma deimited) .csv) =)

[ open I+ |

Cancel |
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Note: The first row of the CSV is expected to include header information and NOT data. The
header should contain names corresponding to the fields (columns) in the file and should
contain the same number of fields (columns) as the records in the rest of the CSV file.

25. Click OK
1
Import Timesheet Data '3
(1) The input file Is expected to be in the CSV (Comma Separated) format. (5) Row Matching is done based on the empioyee’s SSN OR the combination
of the Employee’s (First Name and Last Name).
(2) The first row in the file is expected to Include hoader information and NOT data.
(6) You cant have multiple employees with the exact same name (first name
(3) The input file should not iInclude more than one row per employee. and last name).
(4) Any row that doesn't match an existing “Active™ employee (in the (7) The number of hours should be in Decimal format. For example: enter 7.25
currently open company) will NOT import. for 7 hours and 15 minutes.
Step (1) Click here 1o Load the Timesheet CSV file. ” Heip Online l
Unused 1 Unused 2 Unused 3 Unused & Urused 5 Unused 6 Urwsed 7 Unused 8 Urused 3 Unused 10 Un{
»  PayrcllID Employee Number  Name Growp. Salaned Exemgt Reg Hours OVT Hours O Hours. Hed
0 Deaux Fred . 0 0 0 2 0 0
0 Sargle 0 0 0
0 Sargle 0 0 0
4 Seile 0 0 0
0 Tester o Payroll Mate has successfully loaded the CSV file. 1 0 0
[ Testee 0 0 0
Please stant by mapping all the requared fieids.
You can map any of the fields by clicking the column header at the top Cllck OK 25
and then selecting the desired field from the menu.
When you are ready to proceed with importing the data, please click
the Import button below the employees list.
« m J »

Step (2) Click here to Import the Timesheet Entries into Payroll Mate

| Close ]
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26. Map each column

When mapping your columns, click the word “Unused” for each column and select the correct
column data description

m

(1) The input file Is expected to be in the CSV (Comma Separated) format. (5) Row Matching is done based on the employee’s SSN OR the combination
of the Employee’s (First Name and Last Name).
(2) The first row in the file is expected to include header information and NOT data.
(6) You cant have multiple employees with the exact same name (first name
(3) The input file shoukd not Include more than one row por employee. and last name).
(4) Ay row that doesn't match an existing “Active™ employee (in the (7) The number of hours should be in Decimal format. For example: enter 7.25
currently open company) will NOT import. for 7 hours and 15 minutes.
Step (1) Ciick here to Load the Timesheet CSV file. ” Help Online
Unused 1 - B L W— TS Urwsed 7 Unused 8 Unused 8 Uewsed 10 Unf
»  PayrcllID SSN(USS-08-50838 of SeRessees) Reg Hours O Howrs O/T Hours. Hed
! First Name(Max 50 characters) @0 2 0 0
Last Name - Already used ‘:z g : g
Hours for » 37 0 0 0
&0 1 0 0
Unused k] 0 0 0
Map the 26
Columns
<k - — J »
Step (2) Click here to Import e Timesheet Entries into Payroll Mate ]
| Close ]
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27. Click Step (2) to Import the Timesheet Entries

m

(1) The input file is expected to be in the CSV (Comma Separated) format. (5) Row Matching is done based on the employee’s SSN OR the combination
of the Employee’s (First Name and Last Name).

(2) The first row in the fe s expected to iInclude header information and NOT data.
(6) You cant have multiple employees with the exact same name (first name

(3) The input file should not Include more than one row per employee. and last name).
(4) Ay row that doesnt match an existing “Active™ employee (in the (7) The number of hours should be in Decimal format. For example: enter 7.25
currently open company) will NOT import. for 7 hours and 15 minutes.
Step (1) Click here to Load the Timesheet CSV file. ” Heip Online .. I
4M1 Unused 2 Last Name ‘Fmerm Uresed 5 Unused 6 Unused 7 RongPo Overtimme Hourly P UruqllO Un{
»  PayrcllID Employee Number  Name . Growp Salaned Exemet Reg Hours O Howrs O/T Hours Hed
= ) Desux Fres . 0 0 2000 200 0 [
0 Samgle Semuel 0 0 R0 000 0 0
0 Samgle Sant 0 0 200 000 0 ]
0 Smile Stacy 0 0 3700 0.00 0 0
0 Tester Sally 0 0 2000 100 0 ]
0 Tester Tommy 0 0 2w o 0 0

Click Step (2) Click here to Import the

Timesheet Entries into Payroll Mate i

« © & _m J ’

I Step (2) Click here to Import he Timesheet Entries into Payroll Mate

( Close J

Payroll Mate® www.PayrollMate.com info@realtaxtools.com Page 13 of 14



http://www.payrollmate.com/
mailto:info@realtaxtools.com

28. If there are no errors in your CSV file, you will be taken to the first check to create

Note: Verify Begin Date, End Date, Pay Date and Check #

Note: Edits to payroll check can be made here as needed (including edits to rates, hours, tax,
deductions, etc.) Pay special attention to employee(s) with non-hourly income (salary, bonus,

per piece, etc.)

Import Timesheet Data

First Employee check| 28

(1) The input file IS eXPeCicu w e we ure wov VU T aiEu) r e

(2) The first row in the B ey oy oo i
(3) The inpat file should ¢ Genersl Information Pay Frequency: Weekly (52 Pay Penods)
Employes  Desux Fred | Bagn dne 25 2018
(4) Any row that doesn't SN <
currently 0pan Compamyl Oneck #: 36 | PayDute: ame 25201 3+  EndDse. Ane 252018
\ Income Detalls Vacation / Sck Howrs
| Step (1) Chick here to
‘ nlvooa P - A ' ;oom %oo ' Ll
; Houty Pay 200000 Por Hour 4000 Vi camed 1
| [Unused? U Vacation Pay Houly 200000 Per Hor 0.0000 000 000 NG xw 0{:
[»  PayrclliD E Sck Pay Houdy 200000 Per Hour 0.0000 000 000 b h
0] Ovetme Houdy Pay 300000 Per Hour 200 6000 6000 houss eamed
o Sick hours wsed 000
of e . . Dedsctiondetals —
of I Amouet, i3 - Amount, ap.
O Federal ncome Tax 546 41530 401K Employee) 3440 15840
O] Socal Securty (Employee) 532 4552 Heath Insurance 2500 125.00
Medcare (Employee) 1247 5742 Percert of Net Pay 2657 10121
State Income Tax 4257 19463 =
Loeal Income Tax 000 000 g 40K (Ergoye) 1720 n2
Sate Disadity Insurance (Employee) 000 000
Oricago Cey Tax 088 1%
Cook Courty Tax 6235 2879
2nd Cook Co Tax 215 815
Socil Securty (Employer) 5332 4552
Medcare (Employer) 1247 5742 of
Other Optional Detalls Check Semmary ;
Gmouet  YID. Toincomes:  Total Taxes: Total Qeduchcen.  Net Pav
Hours Wordked 000 00 This Chack.  §60.00 26913 8597 504 85
Weeks Woked 000 00 an. 3360.00 121208 41118
MEMO
|« | Create Check & Goto Next Empioyee | | Skip Employee | | Quit Crestiog Checks |  Employee 106

Step (2) Click here to Import the Timesheet Entries into Payroll Mate I

Close

(5) Row Matching s done based on the employee’s SSN OR the combination
olthe Lo U

- B

occoooic

Note: Click Create Check and Go to Next Employee to create this paycheck
Note: Click Skip Employee to skip this employee and not create a paycheck

Note: Click Quit Creating Checks to cancel creating checks

Things to consider

1. Any employee imported with a Valid SSN/Incorrect Name — Payroll Mate will create the check

based on SSN of employee already inside Payroll Mate

2. Any employee imported with an Invalid SSN/Correct Name — Payroll Mate will create the

check based on employee name already inside Payroll Mate

3. Duplicate employee listed in CSV — 2 paychecks will be created by Payroll Mate
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